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C H A P T E R 1

Overview

This chapter provides an overview of what happens as a result of the installation process, such as which 
packages are installed and how environment variables are set. 

This guide explains how to install the servers used by both the web applications and the WAE platform.

• Before You Start—Requirements, best practices, and pre-installation instructions.

• Online Installation—Procedure for installing the software when you have access to the Internet.

• Offline Installation—Procedure for installing the software when you do not have access to the 
Internet.

• Post Installation—Optional procedures to follow after having installed the product, including 
pointers on where to go for configuration information.

• License Installation—Procedure for installing licenses for all products.

• MATE Design Floating License Server—Procedure for installing and setting up the FlexNet 
Publisher license server. This is applicable only if you have MATE Design and only if you need to 
administer floating licenses for these end users.

• Services—Procedure for starting and stopping services, as well as how to check their status.

• Accessing the Products—Describes how to access the various applications and servers once they 
have been installed and configured.

Installer
An installer is an executable that runs a script to install the MATE and WAE software in the proper 
locations. Although both MATE and WAE features are installed, they are active only if you have a license 
for them.

The installer automates the installation process by asking you a series of questions and performing the 
following tasks.

• Verifies the following.

– Whether the device has the appropriate system requirements, including proper operating 
system, disk space, total memory, and required software packages.

If the installer sees that you do not have the appropriate system requirements, it either exits, 
gives a warning, or prompts you whether to continue. Since the installer might be checking for 
more than what your specific requirements are, you can press “y” to attempt to continue.

– Whether there are existing package installations; if there are, they are preserved
1-1
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• Installs all RPM packages, creates the software directory structure (except for the installation 
directory), and creates symbolic links to the most recently installed packages.

• Sets the maximum file descriptors and processors as follows.

– /etc/sysctl.conf file
Sets fs.file-max=512000 if it is less than 65535.

– /etc/security/limits.conf
Sets nofile to 65535 for the WAE username.

– /etc/security/limits.d/90-nproc.conf
Sets nproc to 8192 for the WAE username.

• Upon logging out and back in, the WAE username and associated permissions are set, and the 
environment variables are set

RPM Packages
The following RPM packages are installed in /opt/cariden/software.

Current Links

MATE (mate) Package
The current symbolic link for the mate package is /opt/cariden/software/mate/current.

WAE (wae) Packages
Other than the mate package, all other packages begin with wae- and all versions of these packages are 
listed in /opt/cariden/software. The current symbolic link is the abbreviated name.

Example RPM version name: wae-core-snapshot-1.0.2-123456789

Example corresponding current link name: wae-core

Package Description

mate MATE software and Collector server, MATE APIs

wae-cdl Open SDN Controller

wae-collector Collector Karaf container, Continuous Poller server

wae-core WAE Core Karaf container, WAE Core server, WAE Core APIs

wae-db WAE Core database

wae-demo Demonstration UI for applications developed for WAE Core

wae-messaging WAE messaging system that uses JMS

wae-platsvc Platform services
1-2
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Versions
To determine the release version, enter the following command.

license_check -version

To determine the current RPM version, enter the following command.

rpm -qa | grep 'mate\|wae'

Environment Variables
Upon logging out and back in as the WAE user after an installation, the environment variables are 
automatically set using .sh scripts in /etc/profile.d directory

Environment Variable Default

$WAE_ROOT /opt/cariden

$WAE_HOME /opt/cariden/software

$CARIDEN_ROOT /opt/cariden

$CARIDEN_HOME /opt/cariden/software/mate/current

$CASSANDRA_HOME /opt/cariden/software/wae-db

$COLLECTOR_HOME /opt/cariden/software/wae-collector

$JAVA_HOME /usr/java/latest
1-3
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C H A P T E R 2

Before You Start

Requirements

Note For a list of system requirements and package dependencies, see the System Requirements document 
posted on the Cisco download site for this release.

• System Requirements— The installer checks for system requirements. If they are not met and if it 
is something the installer cannot address, such as memory issues, the installation process stops. 

• Package Dependencies—For online installations, the installer checks for required packages. If the 
installer cannot install any RPM dependency, it reports an error and skips the corresponding RPM 
installation. You must then install these dependencies and re-run the installer. 

There is one exception to this automatic package installation. For RHEL operating systems, you 
must manually install an RHEL package repository (createrepo) using the Red Hat installation DVD.

For assistance with downloading packages for offline installations, contact your support 
representative.

• License—A license determines which MATE and WAE features are available to use, and is a 
requirement for using the products. If you have questions about obtaining a license, contact your 
support representative.

• Server time synchronization—The NTP (Network Time Protocol) must be used to synchronize times 
on all routers, servers used in the collection and deployment process, and servers used in 
high-availability clusters. Failure to synchronize these clocks can produce such issues as the 
following. 

– Messages might expire prematurely, which manifests as an unresponsive WAE northbound 
interface.   Depending on where the JMS messages expire, you may or may not see indications 
of this in the logs.

– Certain collection tools, such as sam_getplan and flow_get, might produce inaccurate traffic 
tables.

– Collection tools will produce an inaccurate NetIntHistory table.

– All lines in the collection logs will have incorrect timestamps.

• /etc/host requirements—Various web services require the server's hostname to be present in the 
/etc/host file. This is standard configuration practice, but some Linux systems do not have it. Both 
the unqualified and fully-qualified hostnames must be present. Make sure that the following line is 
present in /etc/host.
2-1
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<server IP address> <hostname> <fully-qualified hostname>

Example: 192.168.0.15 wae-server wae-server.my.company.com

Best Practices
Security—The server’s SSL certificate for a domain is customer specific. The web server installation is 
tied to a preferred Certification Authority (CA) provider, which in turn issues valid certificates to web 
clients. To prevent users from seeing messages for untrusted certificates, configure the certificate to be 
signed by one of the client's trusted CAs. The fully-qualified domain name (FQDN) of the WAE server 
should match the FQDN of the certificate issued by the CA.

BIOS setting (if applicable)—To improve collection performance, change or disable the power 
management setting to permit maximum CPU performance.

Pre-Installation
These pre-installation steps are valid for both online and offline installations.

Step 1 Download the WAE software package, which contains both MATE and WAE software. In a web browser, 
go to the Cisco download site, and use the Search feature to find the applicable product.

Step 2 Log in to the server as root or a user with administrative capabilities.

Step 3 Create an installation directory that has root privileges. The best practice is to use the default installation 
directory, which is /opt/cariden.

cd ~/

mkdir -p /opt/cariden

If using a different installation directory, create it instead of /opt/cariden.

cd ~/

mkdir -p /<custom_installation_directory>

Step 4 Ensure there are no local firewalls blocking the services. This step is beyond the scope of these 
instructions, though following is an example. For a list of available ports, see the System Requirements 
document on the Cisco download site for this release.

Example: This shows how to disable the iptables firewall as root.

service iptables save

service iptables stop

sudo chkconfig iptables off

Step 5 Ensure there are no services are running. For 6.1 services, refer to the Services chapter. For pre-6.1 
releases, refer to the following.
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Action Pre-6.1 Stop Command

Stop the web server embedded_web_server -action stop

Stop the MATE Live datastore mld -action stop

Stop the WAE Core server core-stop

Stop OSC (Open SDN Controller) run.sh -stop
2-3
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Online Installation

Step 1 Log in to the server as root or a user with administrative capabilities.

Step 2 Create an installation directory that has root privileges. The best practice is to use the default installation 
directory, which is /opt/cariden.

cd ~/

mkdir -p /opt/cariden

If using a different installation directory, create it instead of /opt/cariden.

cd ~/

mkdir -p /<custom_installation_directory>

Step 3 Go to the directory where you downloaded the software, and execute the installer as root using a bash 
command. The software package is, itself, the installer executable that automates the installation 
process. 

sudo bash <package>.bin

The process verifies the integrity of the installation using checksums. If a checksum fails, error messages 
appear and the installation process is terminated.

Depending on what the installation process finds, it might prompt you throughout the process to continue 
or not. 

Installer Options Description

sudo bash wae-k9-<version>.bin Be prompted through the installation process.

sudo bash wae-k9-<version>.bin -d <installation_directory> Specify a different installation directory. You are 
prompted through the remainder of the installation 
process.

sudo bash wae-k9-<version>.bin -h Shows a usage statement for the installer

sudo bash wae-k9-<version>.bin -y Automatically respond “yes” to all questions without 
being prompted.
3-1
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Step 4 The process prompts you for an installation directory. The default is /opt/cariden. If this is an upgrade, 
the recommendation is that you maintain the same installation directory as in the previous release. If this 
is a new installation, the recommendation is to keep this default.

Step 5 The process prompts you for a WAE username. 

The default is "cariden" only if that username exists; its existing password remains intact. Otherwise, the 
default WAE username is "wae." The default password for the wae username is "ciscowae." 

The recommendation is that you keep whichever default you receive. Also, consider that if you have 
previously installed the MATE Live datastore (mld), you cannot restart mld unless you start it with the 
same username used to install it.

Step 6 The process prompts for whether you want to start SDN platform services, which include wae-core, 
wae-db, wae-messaging, and wae-cdl. The default is "No." Unless you have the appropriate license, this 
service is of no use, but will still uses memory and disk space. The recommendation is that you keep the 
default unless you have the necessary license.

Step 7 Once the installation process stops, log out of the device or VM.

Step 8 Log back in using the WAE username. 
3-2
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Offline Installation

When installing online, the installer connects to the Internet and downloads missing packages. If the 
device or VM onto which you are installing cannot access the Internet, you must manually load these 
packages onto the device where you are installing the product.

This chapter describes a process that puts the packages where the installer can find them.

Prerequisites
• You must have Internet access from another device so that you can download the required packages 

to a memory stick. Then transfer these libraries to the devices or VMs on which you are installing 
the product. All instructions assume you are doing this, and do not explicitly state as such.

• You must have the packages needed for the MATE and WAE installation. You can download a 
CentOS DVD or an .iso file from http://centos.org. These instructions are based on you having the 
“minimal ISO” set of packages.

• Follow the pre-installation steps in the Before You Start chapter.

Offline Installation

Note You must have root permission to perform the following instructions.

Step 1 Create a/media directory.

mkdir /media

Step 2 Mount either the physical CentOS DVD or the .iso file.

DVD: mount/dev/cdrom /media

.iso file: mount -t iso9660 -o loop <iso_filename.iso> /media

Step 3 From the /media/Packages directory, execute the following rpm command to install the following 
packages. Repeat the command for each package.
4-1
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rpm -i libedit-<version>.x86_64.rpm

rpm -i openssh-clients-<version>.x86_64.rpm 

rpm -i libxml2-python-<version>.x86_64.rpm

rpm -i deltarpm-<version>.x86_64.rpm

rpm -i python-<version>.x86_64.rpm

rpm -i createrepo-<version>.noarch.rpm

rpm -i <package_name>.rpm

Example: rpm -i libedit-2.11-4.20080712cvs.1.el6.x86_64.rpm

Step 4 Create a localrepo directory in the root directory.

cd /root

mkdir localrepo

Step 5 Copy all packages from /media/Packages to /localrepo.

cp /media/Packages/* /root/localrepo

Step 6 If configuring HA, download the following CentOS libraries to /root/localrepo. Retrieve these from 
an EPEL mirror, such as can be found on https://fedoraproject.org/wiki/EPEL. 

• ansible-<version>.noarch.rpm

• libyaml-<version>.x86_64.rpm

• python-crypto-<version>.x86_64.rpm

• python-httplib-<version>.noarch.rpm

• python-jinja-<version>.x86_64.rpm

• python-keyczar-<version>.noarch.rpm

• PyYAML-<version>.x86_64.rpm

• sshpass-<version>.x86_64.rpm

Step 7 Create a yum local repository. 

createrepo /root/localrepo

Step 8 Go to the yum configuration directory.

cd /etc/yum.repos.d

Step 9 Create a configuration file to define the yum localrepo directory.

vi /etc/yum.repos.d/local-repo.repo

Add these lines.

[local-repo]

name=local-repo

baseurl=file:///root/localrepo/

enabled=1

gpgcheck=0
4-2
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Step 10 Disable all *.repo files in the /etc/yum.repos.d directory except for the local-repo.repo file you 
created. This step forces the installer to use only /root/localrepo.

Open each *.repo file and change all instances of enabled=1 to enabled=0. To find a list of the files you 
need to edit, enter the following.

grep enabled *

Example:

vi CentOS-Base.repo

Search on enabled=1

Change it to enabled=0

Step 11 Update the repository so that yum knows which repository directory and file to use.

yum clean all

yum repolist

Step 12 Run the installer by following all instructions in the Online Installation chapter. This process creates an 
epel.repo file /etc/yum.repos.d directory and sets enabled=1. This causes the installation to fail since 
it does not check /root/localrepo thereafter. When prompted whether to continue, select “no” to stop 
the installation.

Step 13 Disable the epel.repo file from being used by the installer.

cd /etc/yum.repos.d

vi epel.repo

Search on enabled=1

Change each such instance to enabled=0

Step 14 Rerun the installation by following all instructions in the Online Installation chapter. 
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C H A P T E R 5

Post Installation

Step 1 Install the license or licenses. Collector and the web applications require a MATE license. The WAE 
Core modules require both a MATE and a WAE license. For information, see the License Installation 
chapter.

Step 2 If you are installing, starting, or upgrading the MATE Live datastore (mld), stop the web server. For more 
information about the MATE Live datastore, see the MATE Live Configuration Guide.

a. Stop the web server.

service wae-web-server stop

b. Install, start, or upgrade MATE Live datastore.

– Install and start mld server: mld -action install -size [DSML]

– Start mld server: mld -action start

– Upgrade an existing mld server and start it: mld -action upgrade

c. Start the web server.

service wae-web-server start

Step 3 If you are collecting flow data using flow_manage and flow_get, you must change the file capabilities 
for the flow collection server. This applies to all binaries in $CARIDEN_HOME/lib/ext/pmacct/sbin. If 
not, execute this command on all files in this directory.

Example: setcap 'cap_net_bind_service=+ep' $CARIDEN_HOME/lib/ext/pmacct/sbin/*

Step 4 Both the wae-web-server and the wae-collector are automatically started. Others may have been 
started, depending on how you responded to the installation process. If needed, start other services now. 
For information, see the Services chapter.

Step 5 The licensed features you have determines what needs to be configured. See the Configurations section 
for a list of these and pointers where to go for information.
5-1
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Configurations
The licenses you have govern which of the following configurations are required after having installed 
the product.

• Configure the FlexNet Publisher license server—Applicable if administering floating licenses to 
MATE Design users. For information, see the MATE Design Floating License Server chapter.

• Configure the WAE platform—For information, see the WAE Platform Configuration Guide.

– Configure the Collector module to collect network data and traffic. You can configure collection 
either using the Collector UI or using snapshot configuration files.

– Configure other WAE platform modules, including the Deployer module.

• Configure MATE Live—For information, see the MATE Live Configuration Guide.

– Install and configure the datastore—Applicable if using MATE Live Explore and Analytics 
components. 

– Configure MATE Live to collect the data from Collector—Applicable if using both MATE Live 
and Collector. 

– Customize MATE Live application for its users—Applicable if you are the administrator of 
MATE Live. 

• Customize the MATE Design Archive application for its users—For information, see the MATE 
Design Archive User and Administration Guide.

• Configure system-wide parameters for MATE Live and MATE Design Archive users—For 
information, see the System Administration Guide.

– Configure users and their roles.

– If applicable, configure access to an LDAP server and mappings between LDAP groups and 
MATE roles.

– Configure access to the SMTP server used for emailing MATE Live reports.

• Enhance network visualization—Lay out the network topology for the plan file template used in the 
MATE Live and MATE Design Archive applications. For information, see the MATE Visualization 
Guide.
5-2
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License Installation

A license is required for all features except for sample plan files used in the MATE Design application. 
If you have questions about obtaining a license, contact your Cisco support representative or system 
administrator.

There are three methods of installing a license, and the method used depends on the type of license you 
are installing.

• Stand-alone MATE Design—Use either the MATE GUI or the CLI method.

• Collector and web applications—Use either the web UI or the CLI method.

• WAE Core—Use the CLI method.

MATE Design Licenses

Dedicated Floating

• Each license is unique to a specific 
device.

• Always available (until expiration). 

• No network connectivity is required.

• Must be downloaded to an accessible 
device.

• A single license is shared among users who have 
permission from the license server.

• After installing the license file once, licenses are 
automatically checked out from the server when 
starting the GUI or any CLI tool. When the GUI 
is closed or the tool stops, the license is checked 
back into the license server for use by others.

• You must have connectivity to the license server. 

• There are a maximum number of licenses, and 
you cannot check one out if they are all in use. 

• The FlexNet Publisher license server must be set 
up (usually by a system administrator).

• You must either download the floating license to 
an accessible device, or know the hostname and 
MAC address of the license server. To connect to 
a different port, you need to know the license 
server’s port number.
6-1
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Install License from MATE GUI
To use the MATE GUI, you need either a dedicated or a floating license. Regardless of the license type, 
you need only install it one time. If it is a floating license, thereafter when you start MATE Design the 
floating license will be checked out to you if it is available. By default, licenses are stored in 
~/.cariden/etc.

Note If you previously installed a WAE license, do not use the overwrite option when installing a MATE 
Design license.

Step 1 Start the MATE GUI from the directory that contains the MATE software package.

Step 2 Select the File->Install License menu. 

• If you are installing a dedicated license or if you are installing a floating license and you have it 
downloaded to an accessible device, follow these steps.

a. Select the “From license file” option.

b. Browse to the location or enter the name of the license file (.lic extension), and click Open.

c. Click OK to confirm the license installation. If there is already a license installed, you are prompted 
to either merge or replace the existing license. If you are uncertain whether you have a complete set 
of desired features in the new license, the best practice is to merge the licenses.

• If you are installing a floating license from the license server (that is, you do not have the license 
file), follow these steps.

Best practice: If using Windows, it is recommended that you specify the port.

a. Select the “Specify license file” option.

b. Enter both the hostname and the MAC address of the license server. The MAC address must be a 
12-digit hexadecimal number without any colon ( : ) separators.

c. If the port is not specified, ports 27000-27009 are scanned to find the license server port and connect 
to it. Optionally, you can enter the license server’s TCP port number using a range of 1024 to 65535. 
The default license server port is 27000.

d. Click OK to confirm the license installation. 

Step 3 To verify a license and its features, select the File->License Check menu. 

Install License from CLI
You can use the CLI to install licenses for all products, both MATE and WAE.

Note If you are installing both a MATE and a WAE license, you must use the default method that merges the 
licenses. You are given an option on where to put the license. Choose the same location for both licenses.
6-2
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• For each license you are installing, run the license_install tool, passing it the name of the license 
file (.lic extension). By default, the tool merges the features granted by the new license with those 
in an existing license. 

license_install -file <path>/<filename>.lic

When prompted, enter the number associated with the directory in which you want to install the 
license.

By default, when using license_install -file, the tool merges the features granted by the new 
license with those in an existing license. If you are using only MATE licenses, you can overwrite 
the existing license using the -existing-lic overwrite option. Before executing this option, be 
certain that the new license contains all the necessary features because previous features will no 
longer be available. Do not use this overwrite option if installing licenses for both MATE and WAE.

license_install -file <path>/<filename>.lic -existing-lic overwrite

Example: license_install -file acme/setup/MATEDEDICATED12345678910111213.lic 
-existing-lic overwrite

• If you are installing a floating license from the license server (that is, you do not have the license 
file), use both the -server-host and -server-mac options. The MAC address must be a 12-digit 
hexadecimal number without any colon ( : ) separators.

license_install -server-host <license_server_hostname> -server-mac 
<license_server_MAC_address>

If the -server-port option is not specified, ports 27000-27009 are scanned to find the license server 
port and connect to it. Optionally, you can enter the license server’s TCP port number using a range 
of 1024 to 65535. The default license server port is 27000.

Example: license_install -server-host lic.cisco.com -server-mac 1a2b3c4d5e6f 
-server-port 27000

To verify a license and its features, run the license_check tool. To see descriptions of the license 
features, use the -detail option (which defaults to true).

Example: license_check -detail

Install License from Web UI

Note Do not use the web UI for WAE licenses.

Step 1 Start the web server.

service wae-web-server start

Step 2 Select System->Licenses.

Step 3 Click Upload Licenses.

Step 4 Click Select Licenses.

a. Browse to the location or enter the name of the license file (.lic extension), and click Open.

b. If there is already a license installed, the default is to overwrite the existing license. To merge the 
two licenses instead, select the merge option. If you are uncertain whether you have a complete set 
of desired features in the new license, we recommend that you merge the licenses.
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c. Click Upload License. 

Step 5 Verify the license installed correctly by locating it on the System->Licenses page.
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MATE Design Floating License Server

The FlexNet Publisher license server must be set up if MATE Design users are to use floating licenses. 
Using this server, you can control access to the licenses, monitor who has them checked out, and check 
log activity. 

Note All instructions and examples assume you used /opt/cariden as the default installation directory. If you 
did not, then substitute your installation directory for /opt/cariden.

The FlexNet Publisher license server has two interfaces. One is a CLI, which requires that you start an 
lmgrd daemon so all users can access the floating licenses. The other is a web UI, wherein you must 
install and configure an lmadmin tool; this option offers more flexibility and administration tools. Best 
practice is to use only one or the other interface (CLI or web) to administer the license server.

For information about FlexNet Publisher, refer to the FlexNet Publisher License Administration Guide 
(FlexLM_EndUser_LicAdmin.pdf), which is located in $CARIDEN_HOME/docs.

Prerequisites
You must have the required packages installed. For a list of package dependencies, see the System 
Requirements document posted on the Cisco download site for this release.

Pre-Installation: Windows, Mac, or Different Linux Devices
Follow these steps under these circumstances. 

• If you are installing the FlexNet Publisher license server for use with Windows or Mac operating 
systems.

• If you are installing the FlexNet Publisher license server on a different Linux device than the one on 
which MATE Design Linux resides.

Step 1 Log in to the FlexNet Publisher license server as root or as a user with administrative capabilities.

Step 2 Create a lowercase, alphanumeric username where the first letter is an alphabetical character.

/usr/sbin/useradd <username>
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Set a password. 

passwd <username>

Step 3 Create an installation directory that has root privileges. The best practice is to use the default installation 
directory, which is /opt/cariden.

cd ~/

mkdir -p /opt/cariden

Step 4 Change the owner of the installation directory to the newly created user.

chown <username> /opt/cariden

Pre-Installation: All Operating Systems
Follow these steps on the device where FlexNet Publisher license server resides.

Step 1 Ensure there are no local firewalls blocking the services. This step is beyond the scope of these 
instructions, though following is an example. For a list of ports used, see the System Requirements 
document on the Cisco download site for this release. 

Example: This shows how to disable the iptables firewall as root.

service iptables save

service iptables stop

sudo chkconfig iptables off

Step 2 Download the License Server package from the Cisco download site. Navigate to the MATE Design, 
MATE License Server Software page.

Step 3 The MATE license file’s SERVER statement must be the same hostname as the output from the hostname 
CLI command.

a. Determine the hostname.

hostname

b. Edit the /etc/sysconfig/network file to include the hostname returned in the above step.

HOSTNAME=<hostname>

Step 4 Ensure the /etc/hosts file on the client devices contains the same hostname as identified in step 3. 
(Client devices are the devices that will be checking the licenses in and out of the server.)

Note If you need the license server to listen to a different port other than the default 27000 port, contact your 
support representative.
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Install MATE License

Step 1 Download the MATE floating license file (.lic extension) to a directory of your choice on the device 
where the license server will be installed. 

Step 2 Install the license. You are given the option of where to put the file. Best practice is to put the license in 
~/.cariden/etc. Once the license is installed, it is renamed to MATE_Floating.lic.

license_install -file <path>/<license_name.lic>

Example: license_install -file /opt/cariden/licenses/MATEFLOATING12345678901234567.lic

Install License Server

Step 1 Go to the directory where you installed FlexNet Publisher license server package, and execute the 
installer. The package is, itself, the executable that automates the installation process. 

chmod 755 ./<License server package>.sh;./<License server package>.sh

Example: 

chmod 755 
./MATE_License_Server-2.0rc2-Linux-x86_64.sh;./MATE_License_Server-2.0rc2-Linux-x86_64.
sh

Step 2 If you are going to run the license server web UI, run the lmadmin installer from the 
/opt/cariden/software/flexlm/current/bin directory. 

Although the default is to install lmadmin into /opt/FNPLicenseServerManager, the best practice is to 
install it into /opt/cariden/software/flexlm/current/web.

chmod 755 ./<lmadmin_package>.bin;./<lmadmin_package>.bin

Example: chmod 755 ./lmadmin-i86_lsb-11_11_1_1.bin;./lmadmin-i86_lsb-11_11_1_1.bin

Start License Server

Note The following instructions are for using either the CLI or license web server, but not both. The 
recommended practice is to install and use one or the other.

CLI
To start the license server daemon (lmgrd), enter the following from 
/opt/cariden/software/flexlm/current/bin. 

./lmgrd -c <license_filename> -l <log_filename>.log

Example: ./lmgrd -c ~/.cariden/etc/MATE_Floating.lic -l /opt/cariden/logs/lmgrd.log
7-3
Server Installation Guide for MATE & WAE



    

Chapter 7      MATE Design Floating License Server
  Post-Installation
Web UI

Step 1 To start the license server using the web UI, first configure the following parameters from the 
/opt/cariden/software/flexlm/current/web directory. For more information, see lmadmin -help.

By default, the lmadmin server has a user named “admin” with a password of “admin.” If needed, add 
another user to this lmadmin server. 

./lmadmin -useradd <username> - pass <password>

Import the MATE license file that was installed. 

./lmadmin -import <path>/<license_filename>

Example: lmadmin -import ~/.cariden/etc/MATE_Floating.lic

Start the lmadmin process with its default settings.

./lmadmin

Step 2 Start the license server web UI, which by default uses a non-secure port of 8090. By entering the 
following in a web browser, you are redirected to the secure port.

http:<server_hostname>:8091

Step 3 Click the Administration link, and log in using the an administrative username and password. Both have 
a default of “admin.”

Step 4 Click the Vendor Daemon Configuration tab, click the Administer link, and then and click Start.

Post-Installation

Step 1 Verify the license server port 27000 is running. For example, you can telnet to this port to verify that it 
is running. 

Step 2 Verify the license server is running and listening to port 27000, as well as to the established connections.

Example: netstat -a | egrep '27000[0-9]'

Step 3 Either distribute the same floating .lic file that you installed to all MATE Design users who need it, or 
give them both the MAC address and hostname for the license server. 

After end users install the floating license once, the license is automatically validated from the server 
each time the user opens the MATE GUI or runs the MATE CLI tools.

tcp 0 0 * :27000 *.* LISTEN

tcp 0 0 localhost:48245 localhost:27000 ESTABLISHED

tcp 0 0 localhost:27000 localhost:48245 ESTABLISHED
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Set Up Access Control List for Web Server
If you are using the web server to administer licenses, you can set up an access control list. This is 
optional, but doing so can improve the security of who can access the web server, as well as give you an 
easily maintainable list of license users. To do this, you need to know the user ID for all users who are 
checking out licenses from the license server. The user ID is what they use to log in to their operating 
systems.

For more information about setting up access control lists, refer to the FlexNet Publisher License 
Administration Guide (FlexLM_EndUser_LicAdmin.pdf), which is located in $CARIDEN_HOME/docs.

Step 1 Create and open a file named cisco.opt in /opt/cariden/software/flexlm/current/bin.

Step 2 For each user that you want to grant license access, add an INCLUDEALL USER line.

INCLUDEALL USER <user ID>

Example: 

INCLUDEALL USER akd123

INCLUDEALL USER gbd456

INCLUDEALL USER odd789

Step 3 For each user you want to exclude from accessing the license server, add an EXCLUDEALL USER line.

EXCLUDEALL USER <user ID>

Example: 

EXCLUDEALL USER fea123

EXCLUDEALL USER rgu456

EXCLUDEALL USER ilt789

Step 4 Save the file.
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Services

The installation process automatically starts the wae-web-server and wae-collector services. If you 
answered “yes” when prompted whether to start wae-platsvcs during the installation, the SDN platform 
services (all other services except wae-demo) are started.

You can start, stop, and get the status on all services using the following formats, respectively.

service <service_name> start

service <service_name> stop

service <service_name> status

To determine which services are running, enter the following.

service --status-all | grep -i wae

The scripts for starting and stopping services are located in /etc/init.d, which in turn points to 
/usr/local/bin. Whether these scripts are executed on startup is handled by symbolic links created in 
/etc/rc#.d directories, where # is a number 0 through 6.

You can use chkconfig to disable, enable, and view startup settings. Note that you must have root 
permission to execute chkconfig commands. 

For more information on service and chkconfig utilities, use the man pages. 

man service

sudo man chkconfig

Service Description

wae-web-server Web server used by the Collector server, MATE Live application, and MATE 
Design Archive application.

Note that the MATE Live datastore cannot be installed, upgraded, or started 
while the wae-web-server service is running.

wae-cdl Open SDN Controller (OSC)
wae-collector Collector Karaf container, Continuous Poller server, Continuous Poller APIs
wae-core WAE Core Karaf container, WAE Core APIs
wae-db WAE Core database
wae-demo Demonstration UI for applications developed for WAE Core
wae-messaging WAE messaging system that uses JMS
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Accessing the Products

MATE Design
Use one of the following methods to start MATE Design from the directory in which the MATE software 
is installed.

Double-click the mate executable. To verify the version number, select the Help->About menu. This 
should match the version selected when you installed the product from cisco.com.

From the CLI, enter the mate command and press Enter (Return).

Optional: On Windows, you can associate the plan file using the .pln format with the mate executable. 
Double-clicking a .pln file opens the plan in a new instance of the GUI. 

Note If you only have MATE Design, the rest of this chapter is not applicable to you.

Status 
Other than the MATE Live datastore, Linux processes are started through services. To determine if a 
service is running, check its status.

service <service_name> status

For MATE Live, use this command.

mld -action status

MATE Live
This assumes you have mld installed and if needed, upgraded. For more information, see the MATE Live 
Configuration Guide.

Step 1 To start the MATE Live, the web server must be stopped if it is running.

service wae-web-server stop

Step 2 If the datastore is not running, start the mld server.

mld -action start

Step 3 Start the web server and log into the web UI. See the Collector Server and Web Applications section.
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Collector Server and Web Applications

Step 1 If the web server is not running, start it. This must be running to access the Collector server or the web 
applications.

service wae-web-server start 

Step 2 Open the web home page in a browser. 

https://<server_IP>:8443

Step 3 Log in to the web server. Contact your administrator for your personal credentials.

Default administrative credentials

Username: admin

Password: cariden

Default user credentials

Username: user

Password: cariden

Continuous Poller Server

Step 1 Start the Continuous Poller server if you want to continuously poll for traffic statistics.

service wae-collector start

Step 2 Following are the default credentials. For information on the credentials, if they have changed, contact 
your WAE administrator.

Default username: admin

Default password: cariden

SDN Platform Services
If using WAE Core, start the following services.

service wae-core start

service wae-db start

service wae-messaging start

service wae-cdl start

Following is an example of how to verify that the WAE Core process started and is listening to the correct 
port, which by default is 7777.

Example: netstat -anp | grep 7777
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